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Introduction 

This chapter describes how to use this guide. It also explains how to contact 
Quest Software and to get technical support. 

 

In this chapter Page

How this guide is organized 2 
Special conventions used in this guide 3 
Viewing this guide in PDF format 4 
Need more information? 5 
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How this guide is organized 

For information on… See Chapter… 

This guide and other information available 1 

The concepts and features of Spotlight 2 

How to install and run Spotlight 3 

Explanation of the Spotlight main window  4 

How to use Spotlight on Windows 5 

Problems with Spotlight on Windows 6 
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Special conventions used in this guide 

This guide uses the following typographic conventions. 

Example Description 

The Search button 
The File command 

Bold type is used for the literal names of interface objects 
you use to perform actions (for example, toolbar button 
names, menu names, icon names, dialog box options, and 
dialog box titles). 

File | Save 
The pipe symbol (|) is used to indicate a menu path. In this 
example, choose File, and then choose Save from the File 
menu. 

Variable In code examples, italic type indicates a placeholder for 
information that you need to provide. 

Press ENTER The names of keyboard keys appear in small capital letters. 

Press ALT + F1 A plus sign (+) between key names indicates that keys are 
to be pressed in combination. For example, ALT+F1 means 
to hold down the ALT key while pressing the F1 key. 

Press the DOWN 

ARROW key 
Direction keys are referred to by the direction of the arrow 
on the key top (LEFT, RIGHT, UP or DOWN). The term 
“arrow keys” describes these keys collectively. 
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This guide also uses the following symbols: 

 
See also: A source for further reference. 

 

 Note: Additional information for the user. 

 

 
User Tip: Tips and shortcuts. 

Viewing this guide in PDF format 

This guide is also provided in Adobe® Acrobat® portable document format. 
The PDF file is included on the Spotlight on Windows installation CD. 

To view the PDF file, you need Adobe Acrobat Reader version 4.0 or higher. 

Adobe Acrobat reader is available on the Adobe web site at: 

http://www.adobe.com/ 

http://www.adobe.com/
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Need more information? 

Quest Software product information 

Phone 949.754.8000 (United States and Canada) 

Email info@quest.com 

Mail Quest Software, Inc. 

World Headquarters 

5 Polaris Way 

Aliso Viejo, CA 92656 

USA 

Web site www.quest.com 

Please refer to our Web site for regional and international office 
information. 

Contacting Quest Support 

Quest Support is available to customers who have a trial version of a Quest 
product or who have purchased a commercial version and have a valid 
maintenance contract. Quest Support provides around the clock coverage 
with SupportLink, our web self-service. Visit SupportLink at 
http://support.quest.com  

From SupportLink, you can do the following: 

•  Quickly find thousands of solutions (Knowledgebase 
articles/documents). 

•  Download patches and upgrades. 

•  Seek help from a Support engineer. 

•  Log and update your case, and check its status. 

View the Global Support Guide for a detailed explanation of support 
programs, online services, contact information, and policy and procedures. 
The guide is available at: http://support.quest.com/pdfs/Global Support 
Guide.pdf. 

mailto:info@quest.com
http://www.quest.com/
http://support.quest.com/
http://support.quest.com/pdfs/Global Support Guide.pdf
http://support.quest.com/pdfs/Global Support Guide.pdf
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Spotlight support 

Whenever you have a question about Spotlight, click Support Bundle or 
Contact Support on the Help menu. This creates a file called 
spotlightsupport.zip in your Spotlight directory. This file contains a 
snapshot of your Spotlight installation. Send this file and your request for 
assistance to Quest Software. (support@quest.com.) 

 

 
Support bundles contain information for the active instance only. If 
you are using Spotlight to diagnose multiple instances ensure that the 
correct instance is displayed before creating the support bundle. 

 

About Quest Software 

Quest Software, Inc. delivers innovative products that help organizations get 
more performance and productivity from their applications, databases and 
infrastructure. Through a deep expertise in IT operations and a continued 
focus on what works best, Quest helps more than 18,000 customers 
worldwide meet higher expectations for enterprise IT. Quest Software can 
be found in offices around the globe and at www.quest.com. 

mailto:support@quest.com
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Welcome to Spotlight on 

Windows 

Spotlight® on Windows is Quest Software’s powerful diagnostic and 
problem resolution tool for Microsoft® Windows®. Its unique user 
interface provides you with an intuitive, visual representation of the activity 
on your operating system. 

This chapter explains the main features of Spotlight. 

In this chapter Page

Features of Spotlight 8 
Spotlight concepts 10 
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Features of Spotlight 

Spotlight is designed for ease of installation and use, and offers a range of 
tools for problem diagnosis. 

Easy installation 

Spotlight on Windows has a quick and simple installation program. 

Real-time process flows 

Spotlight graphically represents process flows within a connection, allowing 
you to observe activity in real time. 

Comprehensive information about problem areas 

Spotlight visually identifies problem areas (for example, processes, CPU and 
memory usage, and disk I/O information) and provides extensive drilldown 
capabilities for rapid problem resolution. 

A range of reports and graphs provide you with detailed information about 
your server environment for up to 24 hours. This information can be viewed 
on the screen or printed. 

History for Spotlight connections 

Spotlight provides the ability to collect and replay the behavior of a 
Spotlight connection at a given point in time (such as when an important 
alarm was raised or canceled). For more information Spotlight's historical 
feature, see Viewing historical data in the online help. 
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Corrective suggestions 

When Spotlight detects a condition that appears to be a potential problem, it 
not only informs you about it, but advises you what you could look at to 
diagnose the problem further and suggests actions you can take to correct 
the situation.  

Configurable threshold management 

Spotlight allows you to define the thresholds at which performance 
warnings and alarms will operate. See Metrics, thresholds and severities in 
the online help for more information. 

Audio and visual alerts 

Spotlight alerts you with visual and audible warnings and alarms when 
performance metrics exceed acceptable thresholds. 

Process flow calibrations 

Spotlight provides a calibration process that you can run over designated 
periods to assess the normal speed of process flows on the connection that 
you are diagnosing. The calibration establishes average process flow levels, 
which are then used by Spotlight to determine the speed of the visual 
displays. 
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Spotlight concepts 

Spotlight uses metrics, thresholds, and severities to determine the 
performance statistics of a system. Icons, flows, and labels graphically 
display this information in the main application window (the Spotlight 
home page). 

Metrics 

A metric is a measurable value resulting from a request made against the 
target machine. This query runs each time the main application window is 
refreshed. 

The query provides a performance statistic about the system, and returns a 
value to Spotlight. 

Thresholds 

Each metric is divided into thresholds. Some metrics may have only one 
threshold, while others can have many. A threshold is simply a range of 
values that can be returned by the metric. A threshold cannot belong to 
more than one metric. 

Severities 

Each threshold is associated with a severity. The severity determines what 
action Spotlight is to take when the value returned by a metric falls into the 
range controlled by a threshold. For example, you may set a severity to 
display a color, flash the color, emit a sound, or perform an action. 

Alarms are attached to severities. 
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How they work together 

The following diagram shows an example of the relationship between 
metrics, thresholds, and severities. 

 

In the above example, the query (% of users connected) is run against the 
database, and any values returned can fall into one of three ranges (called 
thresholds). If the query returned the value 20%, the value would fall into 
the range covered by Threshold 1. 

In this example, Threshold 1 is attached to Severity 2. You can choose via 
the Spotlight Console Options window to set the colors of the severity (for 
example, Severity 2 might be set to display in green). The component that 
the metric belongs to then changes to green whenever that threshold is 
exceeded. 
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Installing and Starting Spotlight 

Spotlight can be easily installed from a CD or from the Internet. 

This chapter explains the minimum requirements for installation, how to 
perform installations, how to download subsequent upgrades, and how to 
start the application. 

In this chapter Page

What you need to run Spotlight 13 
Installing Spotlight 15 
Folders used by Spotlight 16 
Spotlight Templates and Connection Profiles 17 
The Spotlight Program Group 18 
Starting Spotlight 18 
Uninstalling Spotlight 19 

 

What you need to run Spotlight 

Before attempting to install and run Spotlight, ensure that you have your 
license key and site message, and verify that your system meets the following 
requirements. 
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Minimum Hardware 

•  500 MHz Pentium III PC 

• 60 megabytes of local disk space 

•  Monitor capable of supporting a resolution of 800x600 or higher 

•  256 megabytes of RAM (minimum); 512 megabytes (recommended). 

•  CD-ROM drive or Internet connection 

•  Mouse 

•  Printer (optional) 

•  Soundcard and speakers (optional) 

Additional Comments 

Colors   Spotlight is designed to run on a desktop area of 800 by 600 pixels 
or larger. It is best viewed on a desktop area of 1024 by 768 pixels. You 
should also set the display to use, as a minimum, the 64K-color palette 
(65536 colors). 

CD-ROM   If you are installing Spotlight from compact disc, the CD-ROM 
drive should be attached to the PC on which Spotlight is to be installed. A 
drive mapped to a network device could be used if a local CD-ROM is not 
available. 

Sounds   Spotlight can use sound to alert you when a threshold is reached. 
You must have a soundcard and speakers installed on your PC for this 
feature to work. 
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Minimum Software 

•  Windows 2000, or Windows XP 

•  Microsoft Internet Explorer version 4 or above 

Installing Spotlight 

This procedure explains how to install Spotlight from the CD-ROM. Before 
attempting to install and run Spotlight, ensure that you have your license 
key and site available. 

Close all other applications before loading the installation CD into your PC. 

You can cancel the installation at any time by pressing the Esc key or by 
clicking the Cancel button. 

To install Spotlight  

1  Insert the Spotlight CD into your CD-ROM drive. 

 
Depending on your system’s configuration, the installation 
program may start automatically. If this happens, follow the 
instructions on the screen to complete the installation and ignore 
steps 2 – 4 below. 

2  Select Start | Run. 

3  Type d:\setup.exe (where d: is the CD-ROM drive identifier). 

4  Click OK. 

5  Follow the instructions displayed on the screen. The setup program 
prompts you for any information, such as your license key and site 
message, required to complete the installation. 

 
By default, Spotlight is installed into the following folder: 

C:\Program Files\Quest Software\Spotlight  

You can choose a different location during the installation 
process if required. 
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Folders used by Spotlight  

The following folders are created on your PC during the installation process 
for use by Spotlight. 

Location Purpose 

\c:\Program Files\ 
Quest Software\Spotlight 

The Spotlight installation folder. 

This is the default name and location of 
the folder and may be changed by the 
user at install-time. 

\\Spotlight\Console The folder used for the Spotlight 
supporting software. 

C:\Documents and Settings\All 
Users\Application Data\Quest 
Software\Spotlight\<ID> 

Contains XML configuration files for the 
Spotlight console. 

\\Spotlight\Console\Help This folder contains the pop-up “What’s 
This?” and Alarm help text. 

C:\Documents and Settings\<current 
user>\Application Data\Quest 
Software\Spotlight\<ID>\History 

Initially empty. Contains the history of 
recent Spotlight connections. 

\\Spotlight\Console\Licenses This folder contains product licenses. 

\\Spotlight\Console\Templates Template files contain metrics and 
thresholds that are customized for 
specific environments.  

This is the location where "factory" 
template files are initially located. Your 
own templates and connection profiles 
are stored elsewhere. For more 
information, see Spotlight Templates and 
Connection Profiles below. 
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Location Purpose 

\\Spotlight\Plug-ins\ This folder is used to store any Spotlight 
add-in programs for use by the Spotlight 
application. These programs may only be 
used from within Spotlight. 

Spotlight Templates and Connection Profiles 

Templates 

The template file for a Spotlight application contains the information that 
controls the standard appearance and behavior of all Spotlight connections 
of the specified type. Spotlight is shipped with a set of templates that are 
suitable for most connections. 

Users select the most appropriate template when a connection is first 
established, and can then customize the settings and save them as a new 
template that can be used as the basis for further connections. You can 
make minor changes from one connection to another, even for connections 
that are based on the same template. 

Connection profiles 

Spotlight uses connection profiles to store information that individual 
Spotlight connections use to connect to a target server or system. 

Template and Connection Profile locations 

When you install Spotlight for the first time, the default location for your 
own templates and profiles is determined by the choices you make during 
the installation process. If you make Spotlight accessible to ALL USERS, the 
default locations are: 

C:\Documents and Settings\All Users\Application Data\ 
Quest Software\Shared\Templates 

and 
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C:\Documents and Settings\All Users\Application Data\ 
Quest Software\Shared\Profiles 

You can change the location used to store Spotlight profiles and templates 
via the Migration wizard. You can also share profiles and templates by 
storing them in a shared network location. By placing profiles in a shared 
location, this connection information can be shared between multiple users. 

For more information, see Spotlight templates and connection profiles and 
The Migration wizard topics in the online help. 

The Spotlight Program Group 

The Spotlight installation creates a new program group called Spotlight on 
the Windows Start menu. Unless you change the default locations during 
installation, this group is located within the Program Files folder under 
Quest Software. 

 

Starting Spotlight  

To start Spotlight 

1  On the Windows taskbar, click Start. 

2  Select Programs | Quest Software | Spotlight  | Spotlight 
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Uninstalling Spotlight 

The Spotlight on Windows Uninstall Wizard assists you with removing the 
application and all associated files from your PC, if required. 

To uninstall Spotlight  

1  On the Windows taskbar, click Start. 

2  Select Settings | Control Panel 

3  Select Add/Remove Programs 

4  Select Spotlight and click Remove.  

5  Click Yes on the confirmation message to proceed with the 
uninstallation. 
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The Spotlight main window 

The main Spotlight window shows a unique view of the activity of a 
connection. The display is based on the connection architecture. 

This chapter describes the Spotlight window in more detail, alarms and 
drilldowns, and how to set the optional settings that are available. 

In this chapter Page

The Spotlight main window 22 
Spotlight alarms 28 
Spotlight drilldowns 31 
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The Spotlight main window 

All Spotlight applications (including Spotlight on Windows) have a main 
window – also known as a Spotlight home page – that helps you locate 
system bottlenecks quickly. 

Within that window, related server statistics are grouped together on panels 
that are connected by a series of graphical flows and icons. Spotlight 
updates these flows in real time so that you can see how quickly data is 
moving through the system. The icons change color as their values move 
through the range of thresholds. 

 

 
You can change the appearance and behavior of a Spotlight home 
page via the Console Options window. 
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Elements in the Spotlight main window 

A standard Spotlight main window (the home page) contains some or all of 
the following visual elements. 

Connection identifier 

 

This label identifies the system you are currently 
connected to, and is located at the upper right corner of 
the Spotlight console. The connection identifier changes 
color to match the color of the Spotlight component 
that registers the highest alarm severity. 

  

The Spotlight browser 

 

 

You can use the Spotlight browser (also known as 
the Connections list) to view the details of one or 
more Spotlight connections. The browser contains 
three connection groups Live connections, All 
connections, and History, each of which can be 
opened by clicking on its bar within the browser: 

You can show or hide the Spotlight browser itself 
via the Navigation Tree option on the View menu. 
You can also open and close the browser by clicking 
on the arrow contained in the frame of the window 
itself. 

Right-click on an item in the Spotlight browser to 
display a shortcut menu of available options for that 
connection, including the options to view the Alarm 
log or History browser, or to close the connection. 
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To view the details of a Spotlight connection... 

Click on an item in the list to display details of the corresponding server. 

Items in the Connections list alert you to any bottlenecks that may be occurring 
in the systems by changing color. Items in the Connections list take on the color 
of the most urgent severity now active on the systems being analyzed. 

The Spotlight toolbar 

The Spotlight toolbar is located at the top of the main window. The toolbar 
provides you with quick access to commonly used commands and functions. 
Click a button on the toolbar to carry out the command. If a button appears 
dimmed, it is unavailable. To see a description of each button, rest your 
mouse pointer over the button. Information about the button appears. 

 
The buttons used to access drilldowns are specific to individual 
Spotlight applications. For more information on product-related 
drilldown buttons, refer to the online help topic specific to the 
product. 

 

The following are common Spotlight buttons. 

Click this 

button... To... 

 
Open a Spotlight connection to a system. 

 
Close an open connection. 

 
Return to the previous window or drilldown. 

 
Go to the next window or drilldown. This option is only 
available if you are viewing a previous window or drilldown. 

 
Pause the current display. Spotlight does not retrieve data from 
the system. Details on the windows or drilldowns are not updated 
until you click the Pause button again or select Resume from the 
View menu. 

 
Return to the main Spotlight window for the current system. 
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Click this 

button... To... 

 
Refresh the current window. This is equivalent to choosing 
Refresh from the View menu. 

 
View the alarm log for the current connection. This is equivalent 
to choosing Alarm Log from the View menu. 

 
Displays context-sensitive online help for Spotlight. For more 
information, see To view context-sensitive help. 

Panel 

 

A panel is a visual feature that groups related 
components on the Spotlight home page. 
Components change color as alarms are raised 
for the metrics they contain. 

Dataflow 

 

Most panels in the Spotlight home page are 
connected to other panels by dataflows that 
show the rate at which data is moving through a 
system. As the rate increases, so does the speed 
of the flow. 
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Button 

 

Sometimes called a process icon. A Spotlight 
component that contains a single value that 
represents the state or existence of a process. 

Container 

 

A cylindrical component that fills up as the 
value it measures increases. Normally used to 
indicate file size or disk usage. 

Gauge 

 

A Spotlight component that shows a 
measurement as a continuous range of possible 
values. 

Queue 

 

Spotlight component that shows a measurement 
as a range of discrete values. The globe at the 
end of the queue is an alarm indicator. 
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Spinner 

 

Spotlight component that shows a measurement 
as a rotating wheel. The higher the value, the 
faster the speed of rotation. 

 

Performing calibrations 

When you open a new Spotlight connection for the first time, Spotlight will 
calibrate the normal operating conditions for that connection. During 
calibration, Spotlight assesses the process flows on your PC and 
automatically configures the Spotlight interface accordingly. 

To re-calibrate a connection at any other time, choose: 

File | Calibration | Start 

Setting color displays 

You can reset the color schemes on the main window, the drilldowns 
windows and the severity visual indicators at any time. These settings can be 
saved. 

To reset color schemes, choose: 

 View | Options | Spotlight Console | Appearance 

Setting the frequency of screen refreshes 

The frequency of screen refresh in seconds for both foreground (the screens 
you are viewing) and background (the screens you are not viewing) can be 
set as a configuration option. 

To set the screen refresh frequency, choose: 
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View | Options | Spotlight Console | Data Collection 

Smoothing metric values 

The default setting for graphs is to not smooth off any metric values. 
However, you can opt to select a sample range on which the smoothing off 
will be based, such as 2 samples or 6 samples. This smoothing effect applies 
to all metrics but can be overridden for individual metrics if required. 

To smooth metric values, choose: 

 View | Options | Spotlight Console | Display | Flow Settings 

Specifying help for main screen components and 

alarms 

You can specify that when you click on a main screen component, you will 
see either the balloon help panel or the default drilldown for that 
component. The default display is the drilldown. 

Similarly, you can choose what you will see displayed when you click on an 
alarm that has been raised. The options are the alarm help window or the 
drilldown that is raising the alarm. 

To set the type of help that is displayed, choose: 

 View | Options | Spotlight Console | Help 

— or — 

Help | Help Options 

Spotlight alarms 

Spotlight alerts you to problems with your database by issuing an alarm. An 
alarm normally involves one of the following actions: 

•  changing the color of the component that is experiencing the problem 

•  flashing the component 
•  sounding an alarm. 
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For a full list of the alarms that may be displayed while you are using 
Spotlight on Windows, and the action you can take, see the online help. The 
online help also gives recommendations for each alarm on how to resolve 
the problem, and where to look to diagnose it further. 

Changing alarm properties 

Alarms are assigned to a severity. To change the properties of an alarm, for 
example the color, whether it flashes, the intensity, the type of sound and so 
on, you must change the properties of the associated severity. This is done in 
the Thresholds page of the Metric Editor window. 

To open the Thresholds page, select View | Show All Alarms and in the 
Metrics window, select the Thresholds tab. 

For more information about the properties of a severity, see Metrics, 
thresholds and severities in the online help. 

Changing when an alarm is activated 

To change when an alarm is activated, you must change the severity 
assigned to a threshold. 

A threshold is a range of values that might be returned by a metric. A 
threshold indicates what severity is used when the metric is returning values 
in the range. 

For more information, see Viewing and editing metrics in the online help. 

Enabling/disabling alarm sounds 

You can enable or disable alarm sounds on Spotlight on Windows. 

To enable or disable all alarm sound, choose: 

 View | Options | Spotlight console | General | Enable alarm sounds for 
action rules 

To enable a sound for a particular alarm, you must first set a rule for the 
alarm. You may select a particular .wav file to use as the alarm sound in the 
following steps 

1  From the View menu, select Options and Alarm Log. 
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2  Select Action rules and New. 

3  Select the conditions for an alarm log filter. 

4  Select the actions to perform. If you wish to play a sound when the alarm 
is triggered, select Play Sound. 

5  In the Rule description panel, click the text {Select the sound file}. 

6  From the Open window, locate the sound file that you wish to use for 
the alarm and click OK. 

Logging and filtering alarms 

The location to which alarms are logged can be modified from the default 
Alarms Log window into a separate folder, or into both if required. You can 
change the severity level at which alarms are logged or displayed. 

Filters can also be applied to the alarms so that only alarms for a selected 
component are displayed. 

To log or filter alarms, choose: 

 View | Options | Alarm Log 

Adjusting graph displays on drilldowns 

You can adjust the density of the graph lines as displayed on the drilldowns. 
The period over which the graph histories are calculated can also be 
changed. 

To set graph line density, choose: 

 View | Options | Spotlight Console| Display 
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Spotlight drilldowns 

Spotlight on Windows makes it possible for you to view your system at 
different levels of detail. 

At its highest level, which is the main application window (see page 22), 
Spotlight displays a visual representation of the status of the major 
components in the current system. The detail at this level is designed to help 
you locate and identify bottlenecks quickly. 

When you have isolated a problem, you can display a detailed breakdown, 
called a “drilldown”, of the underlying statistics by clicking on the 
component showing the problem. 

The following image is an example of a typical drilldown window. In this 
case, it is the Processes drilldown that opens when you click the Processes 
button in the CPU panel on the Spotlight on Windows home page. 
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Screen reference Screen element 

A Processes page of the Processes drilldown 

B Processes table (or Processes grid) 

C, D, E, F Various charts in the Process Details sub-page. To 
view these charts: 

1  Click an item in the Processes table, which opens 
the Process Details sub-page. 

2  Click the Process History tab in the Process 
Details sub-page. 

 

Information Grids 

Drilldowns may contain large information grids that provide information 
about the screen element in the main window. 

Information Charts 

There are also four charts in the example on page 31. They show 
information on processor use, memory use, reads and writes, and page 
faults. 

To zoom in on a chart 

1  Position the mouse pointer in the top left-hand corner of the chart. 

2  Hold down the left mouse button and drag diagonally from left to right, 
then release the mouse button. 

To reset the chart display 

 Click the Unzoom Charts  icon in the top right-hand corner of the 
screen. 
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What’s This? Help 

Help is available for each component of a drilldown. 

To view help 

 Right-click a component and select What’s This? from the pop-up menu 

— or — 

Click  on the toolbar, point the cursor to the component you want 
help on, and click once. 

 
You can also press F1 to open the Quest Help Viewer and access 
the online help file. 
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Using Spotlight on Windows 

The unique Spotlight on Windows user interface provides you with an 
intuitive, visual representation of the activity on a Windows connection. 

This chapter describes the elements of the main application window, the 
alarms and drilldowns available, as well as a description of the Windows 
architecture. 

In this chapter Page

Connecting to a Windows machine 35 
The main Spotlight on Windows window 38 
Spotlight on Windows alarms 41 
Spotlight on Windows drilldowns 42 
The Windows architecture 44 
 

Connecting to a Windows machine 

Use this procedure to establish a connection with a machine running under a 
Windows operating system. Spotlight on Windows supports simultaneous 
connections to multiple systems. This eliminates the need to run concurrent 
versions of the application. Repeat the following procedure to connect to 
another system. 
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Ensure that the system is accessible to client applications. Use the appropriate 
connectivity software to establish a connection between your computer and the 
system if a connection does not already exist. 

Spotlight on Windows requires that you connect to a Windows system using a 
login that is a member of the Windows sysadmin role. This will be the Windows 
login that you enter in the User field. If you are unsure whether or not you have 
this access, contact your system administrator. 

  

To connect to a Windows system 

1  Start Spotlight on Windows. 

2  On the File menu, click Connect... to open the Connection Manager. 

3  In the Spotlight on Windows connections list, double-click New 
Connection. 

4  Complete the following fields in the New Connection window: 

Field Description 

Select Connection 
Type 

Choose Spotlight on Windows from the drop-down 
menu if it has not already been selected. 

New Connection 
Name 

Choose a short and meaningful name for the new 
connection. 

5  Click OK to open the Windows Properties window. 

6  Complete the following fields in the Properties window: 

Field Description 

Local machine Select this option if the machine you want to diagnose is 
the one you are now using. When you choose Local 
machine, most other options in the Properties window are 
disabled. 
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Field Description 

Domain The name of the domain that the specified user belongs to.  

If no user name is entered in the User field, this field should 
also be left blank. 

Address The IP address, hostname, or URL of the system you want 
to connect to. 

User A valid user account on the target system. 

Note: 
Spotlight on Windows needs to use an account with the 
privileges required to retrieve server information, query the 
registry, and access WMI and performance monitor 
objects. An account with administrative rights to the target 
machine allows this. 

Password The password required to connect the specified user to the 
target system. 

Save password 
details 

Select this option to re-use the password whenever you add 
a new connection to the target machine. 

7  Click OK to create the connection. 
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The main Spotlight on Windows window 

The main Spotlight on Windows window shows a unique view of the 
activity of a Windows operating system. The display is based on the 
Windows architecture as shown in the architecture diagram on 44. 

The main window helps you locate system bottlenecks quickly. Related 
system statistics are grouped together on panels that are connected by a 
series of graphical flows and icons. Spotlight updates these flows in real time 
so that you can see how quickly data is moving through the system. The 
icons change color as their values move through the range of thresholds. 
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 This window element… Provides… 

A and  
B 

Toolbar Access to common Spotlight commands and 
functions and access to the various drilldowns 
available in Spotlight on Windows. 

C System panel Information about the operating system of the 
machine you are currently connected to. 

D CPU panel Statistical information about the current 
Windows system such as CPU details and 
usage, and the number of processes and 
threads. 

E Spinners The current value of the indicated item, for 
example 20%. As the value increases, so does 
the speed of the spin. The value is shown in 
the center of the spinner. 

F Memory panel Detailed information about the memory on the 
Windows system. It shows statistics such as 
the amount of RAM on the machine, the 
percentage of soft pages to hard pages, and the 
percentage of disk requests that are found in 
memory. 

G Paging Files panel Information on paging space for all paging 
files active on this system. 

H Disks panel Information about the logical disks. It shows 
the drive letter, size, and amount used. 

I Spotlight browser The Spotlight browser lists all the current 
Spotlight connections. You may switch to one 
connection from another by clicking its name. 

J Network panel Information about the total number of 
connected users, and the rate at which packets 
are being sent from and received by the 
system. 
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 This window element… Provides… 

K and 
L 

Process flows and graphs The current level of activity. As the rate of 
data transfer increases, so does the speed of 
the flow. If the statistic represented by the 
flow moves into another threshold, the flow 
may change color. The combination of 
movement and color makes it easy to spot 
congested areas. 

Graphs show how the load has varied over 
time. 

M Event Log panel A link to the Event Log drilldown, which 
shows recent log items that have occurred on 
the target machine. 
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Spotlight on Windows alarms 

Spotlight alerts you to system problems by issuing an alarm. An alarm 
involves one of the following actions: 

•  changing the color of the component that is experiencing the problem 

•  flashing the component 
•  sounding an audible signal 

Below are some of the main alarms that may appear on the main Spotlight 
window. For a full list of the alarms that may be displayed while you are 
using Spotlight, and the action you can take, see Spotlight on Windows 
alarms in the online help. The online help also gives recommendations for 
each alarm on how to resolve the problem, and where to look to diagnose it 
further. 

This alarm… Alerts you… 

Cache alarms When the level of cache activity exceeds a 
threshold. 

Disk alarms As the logical disk is filling up, and also when 
disk activity exceeds a threshold. 

Event Log alarm When an Event Log entry is found which 
matches an active Event Log severity rule. 

Memory alarms When the available memory (both physical 
and virtual) drops below specified thresholds. 

Paging alarms When there is excessive paging activity on the 
target system. 

Process alarms When processes sustain a high CPU load. 

Windows CPU alarm When the server’s CPU usage exceeds a 
specified percentage. 
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Spotlight on Windows drilldowns 

Drilldowns display detailed information about the database that you are 
diagnosing. Each drilldown contains a series of reports and graphs that 
provide you with specific information about the components of your 
database. The statistics that are available help you identify and anticipate 
performance problems. 

Use this drilldown… To show… 

Processes Detailed information about all processes and 
services currently running on the machine you are 
diagnosing. 

CPU Details of recent processor activity as measured by 
Windows. 

Memory Details about recent physical and virtual memory 
usage. 

Disks Information about the logical and physical disks on 
the system you are diagnosing. 

Network Detailed information about the network activity to 
and from the system being diagnosed. 

Activity Summaries of recent Windows activity including, 
paging and packet rates, CPU usage across all 
processors, the number of threads waiting to be 
run, and the number of I/O requests that were 
queued for each logical disk. 

Single Application Detailed information about specified individual 
processes (or a group of processes) on a Windows 
system. 

Use the Diagnose Single Application page of the 
Spotlight on Windows Options window to choose 
the processes you want Spotlight to analyze in the 
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Use this drilldown… To show… 

Single Application drilldown. 

Event Log Recent event log items that have occurred on the 
target machine. 

Alarm Log Information on alarms, including the name of the 
component that issued the alarm, the date and time 
at which the alarm was logged, and the severity of 
the alarm. 
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The Windows architecture 

This diagram summarizes the architecture of Windows. This architecture is 
the basis for the design of the main Spotlight window (see page 38 ). 

 

 
For more information on the Windows architecture, see A Review 
of the Windows Architecture in the online help. 
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Troubleshooting  

Spotlight on Windows 

This chapter suggests solutions to problems that may occur on opening 
Spotlight on Windows and connecting to a Windows system. 

In this chapter Page

Problems with Network traffic 46 
Network name not found 46 
Disk performance counters not enabled 46 
No information on the Network panel 47 
No change to the data flows 47 
Main window hard to read 47 
Drilldown not displayed when clicking alarm 48 
Product authorization errors 48 
Setting up remote access to a Windows machine 49 
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Problems with Network traffic 

Spotlight on Windows retrieves its data from Windows performance 
counters and the windows registry of the machine being monitored. 

Spotlight on Windows cannot connect to a target Windows machine unless 
it can access all of this information. This means you need to have the 
appropriate permissions on the target machine. 

Also the data must be retrievable over your network. Spotlight uses 
NetBIOS traffic to retrieve perfmon and registry information, so any 
firewalls between the Spotlight on Windows client and the machine being 
monitored must allow this traffic to pass through. 

Network name not found 

When the machine being monitored is running Windows 2000, it must also 
have the Remote Registry service running before you can connect to it using 
Spotlight on Windows. If you attempt to connect to a Windows 2000 
machine that has the Remote Registry service stopped, Spotlight on 
Windows will return an error message: 

 Network name not found 

- or - 

 Network path not found 

Make sure the Remote Registry service is running on the Windows 2000 
machine to which you are connecting. 

Disk performance counters not enabled 

Spotlight on Windows cannot display some disk information properly unless 
the machine being monitored has disk performance counters enabled. This 
will affect the Disks panel on the main screen, and the Disks drilldown. 



Chapter 6 – Troubleshooting Spotlight on Windows 47 

 

To enable disk data collection 

1  On the system to be diagnosed, start a command line window. 

2  At the command prompt, type the following: 

 diskperf -y 

3  Restart the machine. 

No information on the Network panel 

Spotlight cannot display some Network information properly unless the 
machine being diagnosed has the SNMP service installed. 

To enable collection of network data, install the SNMP service on the 
Windows machine. For more information, see Appendix A. 

No change to the data flows 

Either the refresh rate is too slow or Spotlight is paused. Do the following: 

•  To update the current screen, select the View menu and click Refresh. 

•  Check the foreground refresh rate setting (try a rate of approximately 30 
seconds). To change this option, on the View menu click Options and 
then Spotlight Console. Then click Data Collection. 

•  Resume the Spotlight diagnostics by selecting the View menu and 
clicking Resume. (If Resume is not available, Spotlight is not paused.) 

Main window hard to read 

The screen resolution is too low. 

Increase the number of colors your computer is using. Spotlight requires a 
monitor that supports 65536 colors or higher (or Hi Color/16-bit) so that it 
can properly shade its graphs. 

1  Open the Windows Control panel and double-click Display. 
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2  Click the Settings tab. 

3  Increase the number of colors in the palette. If this option is not available 
you should upgrade your hardware. 

Drilldown not displayed when clicking alarm 

The Show help when drilling down on alarms option is on. 

To stop help from displaying when you drill down on alarms: 

1  Select View | Options | Spotlight Console | Help. 

2  In the Alarm Help section, select the Always jump directly to the related 
drilldown option. 

Product authorization errors 

The following are steps that you can take should you encounter an 
authorization problem with Spotlight 

Error Message Explanation and Possible Solution 

Authorization string 
has expired. 

Trial authorization for Spotlight has expired. 

If the trial date has not passed, check that the date on your 
system is set correctly. 

Invalid authorization 
string or site message. 

Either the authorization string or the site message has not 
been entered correctly. 

Make sure that you entered the authorization string and 
site message exactly as stated on your Product 
Authorization sheet or provided by your Quest Software 
distributor. 

Note: The site message is case-sensitive. 
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Setting up remote access to a Windows machine 

When you try to connect to a Windows machine, Spotlight may return the 
following message: 

The registry on "<<MachineName>>" is not accessible. 
You need to connect to this machine with an account 
with privileges to retrieve server information, query 
the registry, and access performance monitor objects. 

Choose one of the following methods to give Spotlight the privileges it needs 
to access the registry: 

•  Connect to the remote machine via a user account that has the 
appropriate privileges.  An account with administrative rights to the 
target machine will allow this. 

•  Use the Registry Security Wizard supplied with Spotlight on Windows.  
The Registry Security Wizard creates a group account that grants its 
members remote access to the registry of the database machine. 

About the Security Wizard 

The Registry Security Wizard: 

•  Creates a new group or modifies an existing one,  

•  Assigns permissions to the group,  

•  Adds and removes members (new groups only), and  

•  Lists the registry keys affected by the change to permissions.  

After a group has been set up with the correct permissions, you can use the 
Windows User Manager to add and remove users. To set up a group 
account with the correct permissions: 

1  Copy the SecurityWizard.exe file from the Spotlight directory to the 
target machine.  

2  On the target machine, run SecurityWizard.exe. 

3  Follow the instructions displayed in the Registry Security Wizard 
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Installing the SNMP Service 

If the system is connected to a Windows NT 4 (Workstation or Server) 
machine, Spotlight is unable to display data in the Network panel, flows, 
and drilldowns. 

To enable Spotlight to collect the statistics required to display this 
information, you must install the SNMP service on the target machine. 

To install the SNMP service 

 
To install the SNMP service you will require the Windows 
installation media. 

1  Open the Control Panel and then double-click the Network icon. 

2  Click the Services tab. 

3  Click Add, select SNMP Service from the list of services and click OK. 

4  When the service is installed, close the Network window and restart 
Windows when prompted. 

 
The relevant Windows NT Service Pack must be re-installed after 
the SNMP service is activated. 
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